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Video of this tutorial
You can see this tutorial as the second and third youtube videos at:
http://www.youtube.com/playlist?list=PL5D590974B7967000
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Introduction to ERD modelling using UML Class diagrams with MagicDraw

1. Introduction
1.1 Acknowledgement

The original version of this handout, was designed for a similar piece of software (System Architect), and was
developed by Dorothy Dologite and Richard Holowczak, at City University of New York.
http://cisnet.baruch.cuny.edu/holowczak/classes/9490/satutorial/ but unfortunately since SA have been taken
over by Telelogic there is no longer an educational version of the software. Luckily over the last few years a
number of alternative Case tools have become available, the two most important being MagicDraw and Visual
Paradigm.

1.2. Where to obtain the software
This depends on who you are:

e Students at The Royal College of Surgeons (Edin.) will be provided with a academic licence, which
allows you to use the personal edition. By default you need to download the actual software from the
magicdraw site (see below).

e All others can obtain the software by visiting and registering at: http://www.magicdraw.com/ for the
free community edition. An alternative with a similar interface is Visual Paradigm (VP-UML).

1.3. Before you begin this tutorial?

Before you work through this tutorial you should have the following knowledge and skills:
e A basic understanding of systems development life cycles
¢ An understanding of the basic terminology used in Entity Relationship Diagrams

e A working knowledge of Microsoft Windows/ Apple environments including working with multiple
applications and windows, dialog boxes, and so on

o Preferably some experience with using a Database Management System such as Access, Oracle or
Base in OpenOffice/Libreoffice, although this is not assumed in this tutorial.

If you feel that you are unable to answer yes to any of the above criteria a good starting point is to work
through is my Database/ systems modelling course or which this is part see section 8 at:

www.robin-beaumont.co.uk/virtualclassroom/contents.html

In 2009 Magicdraw developed a plugin that allows the drawing of Crows feet notation in class diagrams,
however this is not available for the personal edition, if you do have access to this plugin | would recommend
you try it out for this tutorial.

1.4. What are the aims of this tutorial?

This tutorial is the first in a series to introduce you to using a specific CASE tool, MagicDraw Personal Edition
(MD/PA). Because this is the first tutorial it provides you with screen by screen details of what to do. The aim
being to familiarise you with the most common, basic features of MD/PA. By the end of this tutorial you will feel
confident with navigating around MD/PA and with the basics of drawing Class diagrams. Subsequent tutorials
assume you have this knowledge and therefore provide less detailed instructions.

While the complete CASE tool has hundreds of features capable of addressing the complete systems
development life cycle, this practical chapter will focus only on a small, but important subset that of creating a
ERD (Entity Relationship Diagram).
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2. The Scenario
For this tutorial we will be using the following scenario

The business we are modelling is a Travel Agency. In the Agency, a Travel Agent will
make one or more Reservations for a Customer. A Reservation is associated with a
particular Hotel Room at a particular Property and the Hotel room is associated with zero
or more reservations over time (I have highlighted the proposed Entity types/Classes).

3. Why Use a UML Class diagram to represent a ERD diagram?

7 _fran In the past | have introduced ERD

" .= = diagramming tools then moved onto
—ggngﬁamﬂgmgm ! 2 fensugwagttlgggdate date 1 1 1

B P UML diagramming tools, which

invariably has led to confusion and the
inability of some students to move onto
the more complex aspects of UML. In
an attempt to avoid this | have decided
to introduce a simplified UML class
drawing technique to allow the drawing
e of a ERD roughly semantically
e equivalent as a way of demonstrating how ERDs can be created using a
Ritberty I UML mindset and also highlight the relationship between ERD’s and UML

class diagrams.

0

1
room

-room_id : String

-mmay _number ; Integer
-children : boolean
-0ogs © boolean

-cost © String

The relationship between ERD’s and UML Class diagrams is best shown by comparing the two. Looking
above there are two diagrams the right hand one uses ERD symbols for the various relations whereas the
equivalent UML diagram makes use of UML equivalent symbols for the associations.

If you do not understand any of the above please refer to section 11 at http://www.robin-
beaumont.co.uk/virtualclassroom/contents.html

Exercise 1

UML Association Multiplicity The multiplicity value of association end A.
0 - zero and only zero.
1 - one and only one.
0..1 - zero or one.
0..* - from zero to any positive integer.
1..* - from one to any positive integer.
* - any positive integer.

Simple uml Association multiplicity symbols given above equate to the Cows feet notation used in ERD
relationships. Complete the following table to show the various equivalent notations.

UML ERD Meaning
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3.1. Differences between UML Class diagrams and ERD’s

It is important to realise that UML class diagrams offer far more options (‘semantic richness’) than ERD’s, and
also do not follow some of the conventions of ERDs.

ERD entity attributes conventions:
¢ Indicate which attributes are Key fields and often include a Unique identifier (ID) field.

e Display Foreign key fields (attributes) which are often added by the modeller or automatically by ERD
drawing software with the ‘FK_’ prefix.

In contrast in UML class diagrams:

e You do not indicate which are key fields (attributes) and do NOT include a unique identifier field for
each instance, which is called an OID (Object Identifier) as this attribute is assumed to exit.

e You do not indicate foreign Keys (the concept does not exist in uml) but can use a related concept
called a qualifier. (I avoid this).

These are important differences to keep in mind when moving from ERD to UML class diagrams.

For this tutorial we will be accepting the ERD conventions. In other words forcing a UML class diagram
to work like an ERD.

3.2. Starting Up MD/PA

‘ It is assumed that you have MD/PA installed See appendix 1 concerning installing MD

In this section, the basic techniques for starting up the MD/PA will be described. MD/PA is a Windows
software application that runs within the Microsoft XP operating system. As with most Windows applications,
starting SA/SE is simply a matter of clicking the left mouse button on the Windows Start menu as shown here:

Start the program by going to "Start" M menu, selecting (All) Programs, then MagicDraw UML
then MagicDraw UML by clicking on it as shown below:

. 3 Audadty
E EQS 6. 1 for Wir

ﬂ Gigabyte 2

) aMT b

G MagicOraw UML

ﬂ BBC Music Magazine » T MagicDraw UserManuadf

|.|‘2| Mera v 32 Uninstall MagicDraw UML
uj Windows Media Bonus Pack for Windows XP b
Iii‘StarI: J 7= ZoneA l.li Adobe »

The magic draw screen will appear.

After which you may be asked to check or download various
o updates please select — no. Many of the updates you are
@r offered are not appropriate for the academic version and you

will just waste time attempting to install them

Architecture Made Simple

17.0
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4. Creating and editing a new Project

Before you can do anything in MD/PA you need to either create a new project or open an existing one. We will
create a new project which will model the above scenario:

We will initially concentrate on the two classes, Travel agent and Reservation.
To create the new project Choose the menu option File -> New Project

Then Give the new blank project the name Travel agency and select a sensible project location | typed
C:\uml\travel agency and clicked the option Create directory for project.

: Fle Edi Mew |syout Diagrems  Options  Tool ENEW Project il

=1 TY L RN

Mame: |travel agency

Project location: |C:'|,um|'|,travel agency I

[v Create direckory For project and related datz

Project
from Template

(o4 | Cancel | Help |

Manage Projects:

MD/PA then creates and loads the new project:

E Load Project

Parsing : UML_Standard_Profile.xml ...

|i Cancel |

The MD/PA main screen is divided into four
main sections:

1. Along the top are the menus and a button / tool bar.

2. The Project pane appears on the top left hand side

3. Properties pane

appears Ina Sma” El-iagicDraw UML Personal Edition 12.1 - travel agency.mdzip [C\uml\travel a ;|g|5|
WlndOW belOW |t. ! File Edit Wiew Layout Diagrams ©Options Tools  Analyze  Window  Help . 4
4' The I’Ight hand E D = n n a .'ﬂ - 4’ - (’ 'l EIC:'I,um...gency\,traveI agency.mdzwpﬂ Hh z |EI

% Conkai,, rﬂgﬂ Inherit, . rihﬂ Diagrams r<> ModzlE.

Containment o B x

side of the screen,

| Project pane with 4 tabs

is reserved to = 0 o The most important is the
d ISp|ay Open m UL Standard Profile [UML_Skandard_Profile. xml] Diagrams one

diagrams and

All of the details
for a particular
project, including
diagram  details,
are stored in a
database which is
often also called
an Encyclopedia

or Data

[Ready -

€35 Zoom rl% Dacurmentation r Propetties

Zoom o & x
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4.1.

Creating a new diagram

There are several ways to create a new diagram you can either click on the class diagram icon or select the
menu option Diagrams -> Class Diagrams.

E MagicDraw UML Personal Edition 12.1 - travel agency.mdzip [C:\uml\travel agency\travel agency\]

: File Edit ‘iew Layout | Diagrams | Options Tools  Analyze  Window  Help Create or open an
H ] 0 T
iODEE LB M- existing Class
EHE Cantai.. rﬁgﬁ Inherit. @ lUse Case Diagrams. .. Ctri+2
Diagrams Communication Diagrams. .. Chrl+3
~ @ Sequence Diagrams. .. Chrl+4
(& - . or here
State Machine Diagrams. .. Chrl+5
Bl Diagrams
_____ £ Ackivity Diagrams Protocol Stake Machine Diagrams. .. Chrl+6
----- {7 Class Diagrams @ Activity Diagrams. .. Chrl+7
---- = Commur.ncatmn Dia oy Implementation Diagrams. .. Chrl+8
----- {1 Composite Structur
..... 7 Dependency Matri Composite Struckure Diagrams. .. Chr4-2
""" 3 Implementation Dia Dependency Matrixes. ..
----- {1 Protocol State Macl
----- {1 Sequence Diagrams Customize. ..
----- 771 State Machine Diag @l Frevious Ciagram el
5% Foom | [ Documents | Next Diagram Alt-Right
Bl Load all Diagrams

Select
diagram.

Mame |

ECreate Diagram

1. Click Add
I

e | add |

Ry

General I

Type Class Diagram name:

—_—

_I Etlass Diagrams

Itravel agency

Select owner Fo&m:

the menu option

Diagrams-> class

Follow the instructions opposite to create a class
diagram called travel agency.

Som N

E-E8 UML St 2. Type travel agency for the
new diagram name

ey

1R =

Close

Click Close

So that you can begin drawing

QOpen |

3. Click OK
Remave |
4 [ ] nse
/ Create | Clane | — —
OKV | Cancel | Help |
W

E MagicDraw UML Personal Edition 12.1 - autosave.md

Exercise 2

| File | Edit Yiew Layout  Diagrams  Options  Tools
[ Mew Project... cti+M | Please carry out what | have described above.
| B2 oOpen Praject... Chrl+ ?
_?
F= MElose Project o
B Close all Projects =

Use Module, ..

Save as Image...

Remember to always
save your project

robin@organplayers.co.uk
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4.2. Drawing

.mdzip [C:\uml\travel agency\travel agency) ]
Analyze wWindow  Help

.gencyltravel agency. mdzip lll @ @ @ o

1 travel agency
- i

I The selection tool

itHn:Ul:l ixrx[i&'ﬁﬁﬁfﬁ

| 1 Common | packﬁage Ds:uta[ Etra'-.fel s}gencﬂJ
2| || = Mot S I A
abe Text Box o : : : : . . . . .

E=] Image shape

---- Separakor ¥

o] Class Diagram

— Interface : . . . . . . | |
—| B3 Package 2 L S P
? ' Generalization  + : : - : : : : : _

o Aggregation A ..Tn create a new Association click here

o Compasition '

A Inkerface Reali.. w || 0o
N Usage ¥

,-::.ﬁ.l:ustractiu:un - ,,,+
[=] Instance

ALiI’Ik
[ Information Flows |ﬂ

Removing the grid from the drawing
canvas ; : : —

Specification

The grid is m nnoyance! To remov i i
. €g dis y pet annoyance 0 remove Diagram Properties... Shift+Enter 1. Right ITI.I}I.ISE click
It: anywhere in a empty
Symbal{s) Properties... Alt+Enter part of the canvass to
Show Diagram Frame ‘ bring up this menu
. Shows Diagram Info
Show Ownier
Go To 4
Select in Containment Tree AlL+E 2. You may need to
Find in Diagram ctrivshifen | |click on a down arrow
first
Related Elements »
[ Prink Active Diagram k Snap Paths to Grid
Layout » Snap Shapes to Grid
Close Diagram Chrl+F4 (@rid Size...
Close All Diagrams But Current Ckrl+35hift+F4
Close Al Diagrarms Chrl-+alk+F4 3. Unselect Show grid
-
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4.3.

Creating Classes

] Common

travel agency
% H & I'sure you are in selection

1. click here first to make

mode

package Da

= Mote

abec Text Box

B anchar

1 Dependency
E= Image Shape
---- Separatar

Class Diagram

2. Click on Class then click |-
where you want the new
class to appear on the

canvas

P

E Class

— Interface
7 Package
" Generalization

#

Once you have positioned the new class on the canvas a rather cluttered object appears this is because of
something called Smart Manupulation — a feature that the company claims makes using the software easier.
Basically each of the dots / icons allow you to add / edit or remove various elements from the class to find out
more go to help -> user manual. A similar feature exists in Visual Paradigm called the Resource Centric

Interface.

Suppress
Aftribates -

Suppress
Operations -,

Suppress
Structure

There are two types of Smart Manipulators:
1 Sm|c1|| buttons are displayed within the symbol on the diagram pane. .

Insert MNew

 Aftribute
; . delwers

r Insert Hew Cummer$hipmerl+ > Order

s Operation .

5 0.x f 1.
— Fesat labels
g position

2 Smart Manipulator toolbar, which appears when elements are selected on the
diagram pane.

7 Toolbar
&
Class A
operationg) ?F:;;d
P oorar Taken from Magicdraw user manual
‘v ver12.1 page 4-141

. Set Preferred

Hyperlinks: Size

s Smart Manipulator

robin@organplayers.co.uk
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Adding names to classes:

Ele §g¢.¢a&$ﬂjt§l i/r"/.lizwﬁﬁﬁli@l@
[ Common | pach Data[travel agencyy
= Mate i
abe Text Box '
B anchor -

_ Dependency
Image Shape [You can easily add names to classeg hy_ c_Iicking
on the top compartment and typing it it.

---- Separator - N
- Class Diagram

E Class -

—C Interface

3 Package -

j? Generalization -

/" hssaiation travel_agent reservation
o Aogregation

./ Composition

& Interface Reali..,

0 Usage v

4 Bbstraction v

4.4. Editing and Adding Attributes

1. Click on the class you wish to add the attributes to. Click on the bubble and type in
the name - repeat as necessary

2. Select the Insert new attributes bubhle

reservation

Pl

To add / edit attributes simply select the class then click on the relevant bubble.

—agent_id
-agent_nams
-agency phone

NN S R N

Name Data Type In this example, | have added 3 attributes to the Travel Agent entity
Agent_id string Also notice that | have specified what type of attribute each is. If you
— have worked with databases you will be aware that data is classified
Agent_name string into a number of types, the five basic divisions are:
Agency_phone string

String or Char = characters you may also specify how many characters are probably required

Numbers = Integers and real numbers

Boolean = This type of data is where it can only take one of two values such as Yes/no or open/closed etc.

Binary = Media such as pictures / audio and movie files
Date/Time
We will now edit the above attributes to specify exactly what type each is.

robin@organplayers.co.uk D:\web_sites_mine\HIcourseweb new\chapll\case_tool_tuts\magicdraw\erd1l_2007_new.docx Page 9 of 19
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Specifying attribute types

r ) 1. Select the class
travel_agent =
- Specification H
-agent_id Diagram Properties. ., Shift+Enker \.‘ 2. Right mouse click to bring up the menu with the
_ specification option
agent_name Symbal{s) Propertiss. ., Alt+Enter P P
-agency_phone -
Show Diagram Frame 3. Select Attributes then open up the branch te show
Show Diagram IrFo the attribute names
T — - L, 4
Eclass - travel_agent x|
B ‘ = = Histary 1| :
= : enwjhor 4. You can change the
rav;‘agen Fati ke number of properties
Ato;iubrznsensa r|n =| e B B Properties:|Standard .| ?hawn for each
tandard attribute - You should
. = Property - not need to change
@ -k [T, - -+cref P | this
& -agent_name Al
Type
""" Ports visibilik etk
Operations I1SIDINE Yy Prvace
chaviors Default Yalue
Template Parameters Cwiner £ travel_agent
Inner Elements applied Stereotype
----- Relations Mulkiplicity
ags To Do H
----- Canstraints
" , ”~ SN U O PR .
iy SN LN Ut A NP A '

- = Histary ;| =2 travel_agentj
t | E —agency_phone—————————— . R
IE vggffriZHtatinn,l'Hyperlinks Click on Type then move down to select String
=] E"i E'-i j I-'rl:lpertles:lbtanl:larcl jﬁ, k.leLuuu.cl::I
- -EII;IE!FII:':,-'J:IhI:IrIE O Property
[ O -agent_id Marme agency_phone
- -agent_name
5 Parks Asn <UNSPECIFIED = _E
Operations Wisihility @ shart [IUML fandard Profile::Mag <
Behaviors Default Yalue =% source [Aghfact] [UML Standard F
Template Parameters Chaner «% specififian [Classifizr] [UML Skal
Inner. Elements Applied Stereatype W1 String [UML Standard F'rn:nFile::l_ll'-ﬂ
Relations Multiplicity 4% subsyskem [Component] [ML Sk
Tags Ta Do YRV BN .. Iy YU R o o P Sy hal __
----- Constraints 1| I 4 ]
= |
- ,\\ =, gt Lk, J" s -".-M.\\ f""*—‘t 4—’# = e

The diagram then gets updated to:

-
travel_agent Repeating the above travel_agent
B : process for the two T .
agent_id other attributes > -agent_id © String
-agent_name _ results in: -agent_name : String
-agency_phone | String -agency_phone  String
|

Exercise 3

Please carry out what | have described above.
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| repeated the above exercise by adding the following attributes and specifying there type in the reservation

entity type (class).

Resulting in:

travel_agent

—agent_id ; String
-agent_name : String
-agency phone : String

Name Data Type

code character
Reservation_date date

Room_type character

:| File | Edit

E MagicDraw UML Personal Edition 12.1 - autosave.md

View Layout

Diagrams  Options  Tools

reservation

-code ;- String

-reservation_date : date

[ Mew Project... Chrl+M e
B Cpen Project,.. kel ?
Chrl+5 =

A . Save Project
-room_type . String [ B “Elose Project
B Close all Projects

Use Module, ..

Save as Image. ..

Remermber to always
save your project

Exercise 4

Please carry out what | have described above.

4.5.

Defining a Relationship among the Classes

-

0|0 Q|
Find: assnmatmnl
$7 Aasnclatmn (BF m

@ 7 M-ary Association

M

.-"""- 4. select the first found item

@7 UML 2.0 in Class diagram

AR EE |

To bring up the help window:

1. you need access to the internet
2. Select menu option Help -= Help
contents
3. Select the lens icon and type in
association

@ 7 Association Class

@ 5 Compensation Association
@ 5 Select Attributesifssociation
5 Link

@ 4 Creating relationships amao
@ 5 Drawing a link hetween twao
@ 3 Creating associations fram
& 3 UML 2.0 Elerments

@ 2 Drawing associated classe

@ 2 Assigning behaviar diagram—

@ 2 Caonnectar End
@ 2 Connectar

@ 2 Drawing a generalization lir
@ 2 Relations pane

@ 2 Initializing roles at both ass
@ 2 Initializing opposite associz
@ | Defaultvalues

& | M-ary Association

1 Enh-:-nrfd flrarm and dron

B

=W EN]y) ends are defined by the Prope

el ssociationy

association is called a link.

association is navigable from the opposite
opposite ends.

= "

P,
- e wmm i mn pmeT

.

=".\
o

memhberEnd, which is assigned to the F'rl:upe.-
Associations. Properties play the role of mefr
Properies that function as memberEnds nf’

o

The default walue of a memher End propery l?

An association describes a set of tuples wh;{

An association specifies a semantic relatiun{
least two ends represented by propedies, eact
than one end ofthe association may have the
owned by an end class orthatis a navigahle o

d

. . .
To show association ends as attributes o

At this point, two classes
have been defined. Now it is
time to link these classes in
an association. In this
example, we will link the
classes with a one-to-many
association.

Before actually drawing the
relationship take a look at
what the MD/PE”s help file
has to say on the topic of
“associations”. You can see
this by opening the help
menu option Help contents
then following the details
opposite. The latest version
of help has moved the
required help shown on the
left to the third of fourth
option down.

robin@organplayers.co.uk
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At the bottom of the information a list of the types of multiplicity can be seen — given below to refresh your
memory.

Multiplicity The multiplicity value of association end A.
e 0 - zero and only zero.
e 1 - oneandonly one.
e 0..1 - zero or one.
e 0..* - from zero fo any positive integer.
1..* - from one to any positive integer.
e * -any positive integer.

Follow the instructions below to create an association.

[ Package A
/f Generalization - ) o
I/'c‘ — |_| ‘ 1. Click on Association
=s0ratan 2. Click on the first class
o Aggregation r /3. Click on the second class N
-/Ccumposition A ‘ x
& Interface Reali... *
,{,' Usage A
A2 abstraction * .
= Instance travel_agent reservation
1 Link —agent_id : String -epde | String
25 Use Case Diagram | -agent_name © sinng -reservation_date | date
4] Implementation Di..,.| -agency phone © String -room_type @ String
@ Composike Strack, .,

@ Information Flows |

We can now specify the multiplicities for each end.

travel_agent

— reservation
-agent_id © String E
-agent_name © String - Jde | String
-agency_phone : String -reservation_date : date

-room_type © String

'. —
1. Double click on the association line to bring

up the association dialogue box
[ﬂg — = = Hiskary :IELEWW

Y

ociation[travel_agent - reservatio

DiocurnentationHyperlinks . . -
fecaciation Ends &l B BX Pruperties:lstandard vI o Custu:umlzel

Template Parameters B Association
Corveyed Information Mame
Inner Elements Ownar

Relations —

= Yisibility

..... . El As=sociation End A

Each of these sections refers to Narme
one end of the association. Naviaabl

We know that a Travel agent is b

associated with zero or more -.M 20

reservations Type
Defaulk Yalue

Change the multiplicity to 0% Visibility
Bl Association End B

1.,
Mame " 9
Mavigable Ly = JJ
- ~,
ey F 3 R - N - - '
o m"- - . ,‘ N _\_“’..—ﬁ S ‘~ o B d.f“ - f“‘
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Introduction to ERD modelling using UML Class diagrams with MagicDraw

Similarly we know that a particular reservation is only associated with one reservation.

travel_agent

—agent_id ;. String

Acce) Fbeee -

Association - <>

-agent_name : String
i

B

—tde Strmg

A
e
e
e

L

ciakin lrl[l'r'El' ¢el_agent - reserya
DocumentationHyperlinks
Aszociation Ends

CeF

EE =3 \EI-""

\ Properties: IStanu:Iaru:I vI B Cust

o

Template Parameters
Conveyed Information
Inner Elements
Relations

Tags

Constraints

Changes to multiplicities
reflected in the diagram

El Aszociation

Marne

Cnner

Visibility
Aszociation End A
Marne

Mavigable
Mulkiplicity

Type

Default Yalue
Yisibility
Association End B
Marne

Mavigable

private

¥ true

Type
Default Yalue

N |1” s —— "
_ e e i A Nisibilibe, _ e - 7
s ;! - \.1/\ \H/k
And the final result
travel_agent reservation
-agent_id ; String 1 0.* |-code: String

-agert_name : String
-agency_phone : String

-reservation_date : date
-roam_type | String

qr"

?
?
<
«./

>

Exercise 5

Please carry out what | have described above. Also remember to

[ MagicDraw UML Personal Edition 12.1 - autosave.md

| File | Edit  Wiew Layout  Diagrams  Options  Tools

Save Project
B Milose Project

i [0 Hew FProjsct... ChrHN
| B open Project... ChrH+O
ChrS

I[ B Close Al Projects

BI-TE]

Use Module...

Save as Image...

Remember to always
save your project

robin@organplayers.co.uk
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4.6. Completing the diagram

The completed scenario consists of four Entities

traVeI_agent reservation (Classes) Shown oppos|te
:gggm—ﬁazmsgr."grmg 1 0.7 :ﬁggg&%gg% Y If it were a ‘true’ ERD rather than a cross between a
_agency_phore - String _room type  String pMI class Qiagram _and a E_RD we quld_ also
include Foreign key fields (attributes). That is in the
. reservation Entity type (class) we would have two
0. more fields (attributes) FK_travel agent_id and
FK_room_id.  Similarly room would have
1 FK_property_id.
(Feetetin Similarly if this were a correct UML class
-roorm_id : String diagram, we would not include the Instance
~fMig_nurmber : Integer (object) IDS such as agent_id and property_id
-children © hoolean and certainly not have foreign keys.
-gogs | boolean
-cost: String
0.+ Exercise 6
1 _Ins_pect_ the class diagram opposite and attempt to
property imitate it:
-property_id Also remember to save your project.

Well done you have nearly finished the first tutorial. However there are some very important administrative
tasks within MD you need to learn now.

5. Extended Exercise
To give you more practice try the following scenario:

A hotel has a single reception.
reception 1 diary The reception makes use of a
single Diary but the Diary is
maintained by numerous
T receptionists or reservation

forms which can be considered to

be a type of input via the

| reception for the diary. The Diary
receptionist reception_form maintains zero or more
reservations. A  Reservation
relates to a single Diary and also
a single customer. Customers

0. make reservation(s). Customers

- can be of two types either

customer 0. [ vacationers or
1 Business_traveler. Once a

customer who has made a

T reservation actually takes up

residence they become a
Hotel _guest. One reservation
v acationer business_traveller may result in zero or more
Hotel_guest(s) but a Hotel_guest
always relates to a single
reservation. Each Hotel Guest
owns zero or more Vehicles. A room can be booked by zero or more Hotel guests who can book one or
more rooms.

Above is an incomplete solution, three entities/classes are missing. | have also made use of a special type of
relation/association called generalisation in two places, you can find out about them in MG help or wait until
you have worked through the introduction to UML section 11.4 at http://www.robin-
beaumont.co.uk/virtualclassroom/contents.html or just use ordinary relation/associations for now.

robin@organplayers.co.uk D:\web_sites_mine\HIcourseweb new\chapll\case_tool_tuts\magicdraw\erd1l_2007_new.docx Page 14 of 19
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6. Useful Tricks and Tips

6.1. Copying a diagram on the fly to a Word document or other
software
P
: File |Edit | Wiew Layoub Diagrams Options  Tools :
i O E—[% Unda Ch+z " ’
S E # FRedo = ’(
Diagra & ot To copy the diagram on the fly just go Q
B | @ cory . o 4
o @ Pt menu option Edit -= copy as EMF file
B r
Paste with New Data then paste it into Microsoft Word using i
B @ Delste Ctrl + V }\*
W Delste Symbol(s) l
Select Al Chrl-f )
Y@ Select All of the Samne T) Chrlal+5 ({
Copy as EMF Image Chrl+Shift+E ~1
Copy as JPG Image Chrl+Shift+13
84 Find... Chrl+F /
e, ﬂ",@yick Figgleten.., Y Bl V. g oA
N LS Rt RS T
6.2. Saving a diagram as a picture

[ MagicDraw UML Personal Edition 12.1 - autosave.my

1. Select Save as image from the File menu

| File | Edit  Wiew Layout  Diagrams  Options  Tools

D[ Mew Project... Chri-Hp¥ie o

2, Select Save

| B2 open Project... +0

u & Save Project 1

= LN A ag
= Close Project

[ neral |
4 B Close all Projects

EEmm—— 4
Use Module. .. ‘

i+ Active diagram

1 CHPr.LicDrawe UML ) integrations

DT = Selected symbols
F ™ Selected diagram gt IEI MagicDraw LML LI ’ﬁ‘ = |
B Print Preview Kot empty. diagrams I bin
Opened Projects = Mame g ::It:

= jre
=i

I manual
| openapi
|- plugins

2 Cihum,. . GP syster
3 CHPr... UMLYsamph

1. Select the appropriate format to save the

picture

For word emf or wmf are good

IL7) profiles

ILT) samples

1) templates

|5 UninstallerData
| update

File name: travel agency

Save

Files of type:

Joint Photographic Experts Group {*.jpg, *.jpeg)

Cancel

|

Encapsulated Postcript (%, eps)

Joint Photographic Experts Group
Partable Metwork Graphics {*,png
Scalable Wector Graphics (*.svg)

'windows Metafile Format * wrf)

Enhanced Metsfile Farmat {*.emf)

(*.jpg, *.jpeg)

)

Exercise 7

Copy your diagram into a word
processing document (e.g.
Microsoft Word) by using the copy
on the fly technique (see above).
Then when in the word processor:

e Attempt to reduce the size
of the picture by dragging a corner
of it on the page so that it takes up
about a quarter of a page.

e Copy some text and right
click on the picture to bring up the
format picture option then select
layout -> square. Notice how the
text now wrapes around it.

e GO to page setup ->
orientation to change between
portrait and landscape mode.

e Finally read in the word
processing help files about creating
continuous section breaks so that
you can create documents with

some pages in portrait and others in landscape orientation. This is important when you have many

diagrams in a document.

Mastering these techniques is vitally important to create well presented assignments.

Video of this

This is discussed further on youtube at http://www.youtube.com/theoldorganplayer

robin@organplayers.co.uk
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6.3.

Linking Diagrams

Suppose that you have a complex class diagram and have realized that a number of classes are basically an
expansion of one particular class for example in our diagram the Class Property could be associated with a
number of classes such as Customer, Staff, Bill etc. It is possible to link the two together on two separate

diagrams:

| =

fistary :IQ property = l

1. Select the class you wish to attach

rProperty the child diagram to e.g property class
i _ ] .
i B B F‘ererties:lExpert ﬂw H Ii
seruation
E Clas=
Hame property| 2- Bring up the Speciﬁca_tiun dialnlgue I i
Qualfied Name croperty| PO and selectdthF ictwehhy_p.e_r.lmk Fring
Owner F Datd , property and click on the "
applied Stereotype ||| |..* |
Base Classifier e
: 3. Insert hyperlinik dialogue box
Realized Intetface appears |
visibility publ 4. select the Element/ Symbol tab ||
Is Leaf [ false 5 clickon®. . "
Is Active false o Iean e
Is Abstrack False : buole;\
_I String
To Do EI

Hyperlink |

Text to display:

The select model element
dialogue box appears
6. | have created another class
diagram which contains
classes conceming a Hotel.
7. Click on Hotel to link the
Property class toit.

syrbal:
rernove the hyvpedink]

v File
| Web Page B

ElementSymbol |

Il [ select Model Element/Symbol
Maodel |

Back |

| e—

=

- Relations

£ manager
- property
£ reservation

£ room
B travel_agent

2] hotel
] travel agency

g

E Diagrams

b 7] Activity Diagrams

E| E Class Dlagrams

i -- travel %ency

----- {7 Communication Diagrams

Rl

£3 WML Standard Profile [UML_Standard_Profile. xml]

1o

Cancel |

Help | |1

The Property Class on the diagram then indicates the hyperlink:

robin@organplayers.co.uk
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6.4. Adding Documentation to a Diagram

k &

abec Tewxk Box
B anchaor

A Containment
' Dependency
Image Shape

---- Separakor

1 travel agency l
I

igé-éaaau::l EfI":/:li&'IETE'

=1 Moke(HTML Text)

¥ note
Camment

[
L3 Comment{HTML Text)

text box

You can create MNotes on diagrams (4 types)

and also Test boxes

H"\-. x.’\-"-.-_.-\.-v(hhd = \'-___ " "‘-\_H -..,- _“'-.___ . ,"‘-\,-“,‘J' ‘\.-'wr\'-'._.__, . A-\\ _.‘rq_t PRy

7. Conclusions for this Tutorial

In this tutorial, you have learnt the basic steps for creating and manipulating a simple UML class diagram
which can be considered to be similar to an ERD diagram. Because the MD/PE product was not designed for
this purpose you may have been confused by the many options that you did not make use of but at the same
time it did expose you to the software. Moving on to UML will provide you with an opportunity to make use of
many of these options and discover the richness of UML.

Robin Beaumont Monday, Tuesday, 04 October 2011

robin@organplayers.co.uk
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8. Appendix - Installing MagicDraw

Details for obtaining Magicdraw are given on page 2.

Remember you need the licence/unlock key (in the form of an xml file) saved on your local machine

before installing MagicDraw. Make a note of where it is.

During or after installation you are asked to provide a licence/unlock key. Click on the Select unlock key

option

mMagicDraw 12.1 Unlock Key

=101 %]

To browse For MagicCraw 12,1 application andjor | ;""g‘é‘[é‘gE"Uﬁiagﬁ"k'gg'ﬁiig(g’)’""gI

® plug-in key filefs), click Select Unlock Key File(s)
buttaon,

Ta connect ta Floating License Server and obtain

Use Floating License |

Floating License, click Use Floating License
buttan.

If wou dao not have key file(s), lagin to

et the Key

hktp: ffwans, magicdraw, com by clicking Gek the
Key button and download them.

Cancel |

Help |

You will then be asked to indicate where the licence/unlock key file is navigate to the correct folder.

You will then be asked which predefined Magicdraw configuration you want, Select System Analyst and then

click OK.

You can always change this from the MD menu Options -> Perspectives -> Perspectives.

E MagicDraw Startup

Business Analysk
Software Architect (Current)
System Analyst

Select predefined MagicDraw configuration according listed Perspectives
~Descripkion

Perspective provides features
primatily dedicated Faor eliciting
requirements and modeling the
system, Analysis features are
highlighted. Configuration is modeling
ariented, Code engineeting,
kransformations and other Features
are hidden,

[¥ Expert

and features will be suggested,

Leave Expert check box nok selected For simplified inkerface. Most popular items

[ |

Help |

robin@organplayers.co.uk
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Iffiwhen presented with either of the following two dialogue boxes click Cancel.

mhuto-check for Updates |

v The Fallowing resources are needed and were not found :
Custom diagram "Content Diagram”
Custom diagram “web Diagram”
Custom diagram "Metworking Diagram’
Custom diagram "Free Form Diagram’
We highly recommend to launch ResourceyPlugin Manager and download the missing resources. Withaut these resources praject will nat be Fuily loaded.

Launch Resource/Plugin Manager Cancel

T Ik EE]

MagicDraw is about ko check For updates

v Shiow this bip nesxt time

Check |

The first screen should then appear, take some time to read through the information about MagicDraw
resources.

[ MagicDraw UML Personal Edition 12.1 - welcome.mdzip [C:\Program Files\MagicDraw UML\samples\] - (ol x|
! Fle Edt Wew Layout Diagrams Options Tools Analyze  Window Help E3

NMPREDGH-- - vl i [capr. UM\ ssmplesimeicome.m. _|' sl EAC R NE] '
By Conta.. rﬁ% Inheri.. | 29 Diagr.. | <> Model.. 1 ~ i Tntro:’ i IMagicDraw Resources I ELERS

4

Conkainment: (=L gg#ms”t:l E/F'Alié'ﬁﬁ%liﬁkeswﬂ%'IE%‘ Dml
| 5 Comman | =
=3 Note .
abo Text Box M i
= T and Trids MagicDraw Resources
Ny B Anchar -
£ UML Extensions /
g UML Standard Profile [UML_Standard_Prafile s <" Dependency . .
- Whats New in 12.0 Image Shape -
— Whats New n 12.1 . | Online Demo
£ Free Form Elements Prafile [Free_Form_Element o
g Matriz Templates Profile [Matrix_Templates_Prof . Class Diagram View online demo for MagicDraw features!
g Metworking Profile [Hetworking_Profile.mdzip] E Class -
3, Profile for UML Extensians o Interface
RUP Extensions Profils Download MagicDraw resources
ke
£ UML Web Extensions Profile [UML_Web_Extensi £ Package F
7 Generalization v You may download
/ Assoiation SysML plugin. Plugin includes SysML profile, all SyshL diagrams, System engineer user perspective with
{ a o customized user interface, specification windows and SysML usability features.
ggregation DoDAF plugin, profile, diagrams and sample. Includes DoDAF mapping to UML. The mapping was created in =
/ Composition accordance with recomendations in DoDAF specifications
4 | j _# Interface Reali... * Zachman Framework sample. This is sample file that show how MagicDraw may be used far Zachman
Bl e L Framework implementation.
o UML 1.4 metamodel. This is sample file that shows UML 1.4 metamodel structure
Z D ati [ ki p
T r@ ocumenta ‘ et .3 fbstraction s UML 2.0 metamodel. This is sample file that shows UML 2.0 metamodel structure.
Properties o /] X =1 Instance MFC template. The template contains classes and various interfaces reversed from MFC include files (like
Symbal | A Link CWinApp) . . . )
L For more resources look in the Resources dialog: choose command Options - Resources from main menu and
4 o2 =f [Stardard + ] @) X | | (3 Information Flows check for availahle resources for MagicDraw. %
- Mew resources may be added any time, so do notforgetto check for available resources regulary!
El Text Box
Autosize [~ False
Wrap Words ¥ true MagicDraw samples
HTML Text ¥ true
MagicDraw samples are located in MagicDraw installation directory, samples folder.
Case studies:
MagicLibrary. The model presented in this case study illustrates how various kinds of UML diagrams may be used
for modeling and developing a library management system_ Itis also a sample of using modules in a project. Case
study includes generated reports
Inventory Control System. The sample is taken from "UML Weekend Crash Course” by Thomas A. Pender.
Features:
Model Decomposition. Samples include explanation how model decomposition is implemented in MagicDraw.
Samples of possible usage cases and hints for using decomposition are included
(Name) Model Transformation. Sample of UML madel transformation to XML Shema and to aeneric DD 2
(Description) | »
/" ¥ Messages Window
Messages Window o 1 ox
Clear
Diagram kype Content Diagram is not registered. Diagram Intro will be loaded as Class Diagram. ﬁl
Diagrarm kype Content Disgram is nok registersd. Diagram Diagram Shapes
mprovements will be loaded as Class Diagram, LI

Text Box Onling Demo Yiew online dema For MagicDraw Features!  Download MagicDraw resources You may download: SysML plugin, Plugin includes SysML profile, all SysML diagrams, System endinser user perspective with custo,, || |
#)start] | Z. zoneaiarm Security suite | [ Ct\magic draw dowrioads | [B™ MagicDraw UML Pers... 5] craft_magicdraw_tutoria.. | Adress [ B QD09 t%H =

When you have had enough Click on the menu option File ->
Close a” prOjeCtS. YOU are now ready to begin File | Edit %iew Layout Diagrams Options  Tools

[ Mew Project, .. Chrl+M p
| B2 open Project... Chrl+Or
»

E  save Project Chrl+5

[ E5  Close Project

Use Module. ..

Sawve as Image. ..

L Print... Chrl+P
B, Print Preview

Opened Projects »

1 CAPr. . UML\sampleshwelcome, mdzip
b

f RUF Extensions Profils
B3 1ML ek Frbensinns Brafile ML Wdeh Frkanic
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